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News

About this newsletter

This newsletter is designed to keep you better informed
about IBM® Content Manager OnDemand on all
platforms. The newsletter is published quarterly.

Previous editions of this newsletter can be found in
support item 7024130. They are also available on the
OnDemand User Group web site under the heading
'"Presentations, Newsletters, and such'.

Correspondence related to this newsletter should be
directed to dbryantl(@us.ibm.com.

This newsletter is formatted so that it is easier to read on
wide screen devices. Use the full screen viewing option in
Acrobat (Ctrl+L) for best results.

Server version 10.1.0.0 available

Multiplatforms

The server version 10.1.0.0 installation files are available
from Passport Advantage. The OnDemand
Administrator and OnDemand Client are also available

from IBM Fix Central. See announcement letter 217-069

for more information.

z/0S

To upgrade your system, choose the applicable PTT from
the list in support item 1260192. See announcement
letter 217-076 for more information.

IBMi

See the Information APAR for a list of the PTTF numbers
for your release. You should also review the
corresponding Read This First document before installing
the PTFs. We recommend that you order the PTF group
when upgrading your system to V10.1.0.0.

Release PTF Group Info APAR Read This First

V7.3 SF99252 1114799 7046944

Note that server version 10.1.0.0 is only available on
V7.3.

Unsupported items in V10.1.0

The following items are no longer supported in Content

Manager OnDemand V10.1:

e The ODWEK 32-bit CGI and Servlet are no
longer supported and are not included in V10.1.
Customers using CGI and Servlet should switch
to IBM Content Navigator (ICN). ICN is
available at no charge to all Content Manager
OnDemand customers. Visit the ICN home page
for more information.

e The Image Web Viewer (ActiveX) is no longer
supported and is not included in V10.1.

e The Oracle Solaris operating system is no longer
supported.

e  Windows Vista and Windows XP are no longer
supported.

Premium Feature Pack available

On April 7, 2017, version 10.1 of Content Manager
OnDemand was released for all platforms including IBM
1and z/OS. Included in this announcement was the
Premium Feature Pack as a new option that includes the
Full Text Indexer, Enhanced Retention Management,
PDF Indexer and OnDemand Distribution Facility
(Report Distribution). These were separate features with
pricing based on Processor Value Units (PVU). You now
have one Passport Advantage part number that includes
all four features for one flat charge. If you purchase the
Premium Feature Pack before September 30, 2017, you
will receive an additional 25% discount off of your
entitled price. You must upgrade to Content Manager
OnDemand V10.1 to take advantage of this Premium
Feature Pack. In most cases this is far less expensive and
easier than purchasing the individual parts (which are still
available with PVU pricing).

There is a YouTube presentation (23 minutes) about the
new release of Content Manager OnDemand including
the Premium Feature Pack. Contact your IBM
marketing representative or business partner for pricing
information.
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Server version 9.5.0.8 available

Multiplatforms

The fix pack 9.5.0.8 installation files are available from
IBM Fix Central. This includes the OnDemand
Administrator and OnDemand Client.

z/0S
To upgrade your system, choose the applicable PTF from
the list in support item 1260192.

IBM i

See the Information APAR for a list of the PTF numbers

for your release. You should also review the
corresponding Read This First before installing the PTTs.

Release PTF Group Info APAR Read This First
V7.1 SF99250 1114497 7018085

Note that server version 9.5.0.8 is only available on V7.1.

Server version 9.0.0.8 available

Multiplatforms

The fix pack 9.0.0.8 installation files are available from
IBM Fix Central. This includes the OnDemand
Administrator and OnDemand Client.

z/0S

To upgrade your system, choose the applicable PTF from
the list in support item 1260192.

AFP Utilities support on IBM i

The last release for the IBM Advanced Function
Presentation Ultilities program product, 5770-AF1, which
provides commands to create AFP resources, was IBM 1
V7.2. The Advanced Function Presentation data stream
is now an open architecture managed by the AFP
Consortium. There are numerous third party products
that run on IBM 1, and on other platforms, that can be
used to create AFP resources. Customers using 5770-AF1
at releases prior to V7.3 should switch to other products
for creating AFP resources prior to upgrading to V7.3.

Note that support for AFP in the IBM 1 operating system,
and in Content Manager OnDemand for i, is unchanged.
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NeWS (continued)

IBM Content Navigator 3.0.1 available

IBM Content Navigator 3.0.1 is available for download from IBM Passport
Advantage and IBM Fix Central. New features include:

¢ A new default style which introduces improvements to various elements
of the user interface such as color, layout, enhanced data presentation,
and button behavior.

e Enhanced URL capabilities that make it easier to leverage IBM
Content Navigator from within your custom applications.

e For improved serviceability, you can change logging levels without
having to restart the application server.

®  You can register additional document MIME types beyond the default
set that i1s currently provided in IBM Content Navigator.

e More than 100 APARs have been fixed.

e There are additional enhancements for Content Manager and Filenet
P8 users.

Documentation is available in the ICN Knowledge Center.
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Tips — Cross Platform — V10.1

New System Administrator (Read-Only) user

Content Manager OnDemand server version 10.1 adds a new user type,
System Administrator (Read-Only). In the OnDemand Administrator
client, users with a type of System Administrator (Read-Only) can view and
summarize objects. The Add, Update, Delete, Copy, and Export options
are not available. Trace Parameters and System Parameters can be viewed
but not updated. When using ARSXML, a System Administrator (Read-
Only) can export all objects, including Trace Parameters and System
Parameters.

User Type

11 () User

() User Administrator
1 Application Group/Folder /Cabinet Administrator

¢

i Hold Administrator
() System Administrator

{

i@ System Administrator (Read-Only)

IBM Daeja ViewOne Virtual 5.0.1 available

The Daeja ViewOne Virtual 5.0.1 installation files are available from IBM
Fix Central. New features include:

e IBM Daeja ViewOne now provides a new edit mode called document
builder, in addition to the annotation and redaction modes. Document
builder mode enables users to add, copy, move, and delete pages in a
PDF or TIFF document that are displayed in the viewer.

e There is an enhanced user interface.
e There are new methods in the JavaScript SDK.

e More than 30 APARs have been fixed.

Documentation is available in the Daeja ViewOne Knowledge Center.

End of Support for IBM i V7.1 \

Support for IBM 1 Version 7 Release 1, including Content Manager
OnDemand for1 V7.1, will end on April 30, 2018. See announcement
letters 917-080 and 917-116 for more information.
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64-bit clients available

Beginning at server version 10.1, the OnDemand Administrator Client and
the OnDemand Client are now available in both 32-bit and 64-bit versions.
The 32-bit and 64-bit clients can co-exist on a 64-bit workstation.

For details regarding default directory path names, registry keys, and other
considerations, see the Content Manager OnDemand Windows Client
Customization Guide.

The following limitations exist in the 64-bit clients but are fully supported in
the 32-bit clients:

In the 64-bit OnDemand Administrator client, the following are not
supported:

e Graphical indexer markup of PDF documents

e Transferring of spooled files directly from an IBM 1 output queue
(by using the Spooled File radio button on the Select File dialog).
To download sample data when using the 64-bit Administrator
Client, use the directions in the 34 Quarter 2016 newsletter, the tip
titled “Creating sample data for a complete spooled file.”

Note that the limitation on transferring spooled files with the 64-bit
OnDemand Administrator client will be removed in a future

fixpack.

In the 64-bit OnDemand Client, the following are not supported:
e (CD-ROM mastering

e Seamless image viewing (for viewing images seamlessly within the
OnDemand client viewing window versus viewing in a separate
window)

e Seamless PDF viewing with Adobe Acrobat (for viewing PDF
documents seamlessly within the OnDemand client viewing window
versus viewing in a separate window with Adobe Reader)

e OLE interfaces
e DDE interfaces

The Version 10.1 and Version 9.5 clients can coexist on the same
workstation.

-E% OnDemand Administrator V10,1

M OnDemand Client V101

dbryant

ok OnDemand Administrator V101
SE! (64-bit)

Documents
B OnDemand Client V10.1 (54-bit)
Pictures
F=8 OnDemand Administrator V9.5

Pusic

L OnDemand Client V9.5

Downloads

ARSXLINE enhancements

At server version 10.1, the ARSXLINE utility has be enhanced to include
the ability to handle overstrikes, and to add an image when creating a PDF
document. The new parameters are:

-g <pdf_image_file> pdf image file (.png or .jpg)

-k <overstrike_mode> overstrike mode (default M - Merge, S -
Separate, F - Full)

-K <pdf_image _mode> pdf image mode (default A - All, F -
First, L - Last)

New ODWEK Java API

There is a new Content Manager OnDemand Web Enablement Kit
(ODWEK) Java API in server version 10.1 to check if the current user can
load documents to the current Content Manager OnDemand server.
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Unique document ID

New in server version 10.1, the unique document identifier provides
improved document addressability. A new application group field check
box called Unique ID is added to the application group definition for
application groups that are created on a V10.1 server. The database field
that is designated as the unique document ID contains a 36-byte string that
is similar to:

75b820e3-bbab-4e3e-975f-171ec38321c4

The value uniquely identifies the row in the database. If a document is
stored with more than one row of indexes (multi-key), each row will have a
different unique document ID.

The Unique ID check box will only be active if the data type of the field is
String, the Type is either Filter or Index, and the Application Identifier
Field, Reference, Partition, and Cluster check boxes are NOT checked.
The String Case is set to Lower, the String Type is set to Fixed, and the
String Length is set to 36.

-

Add an Application Group

- —— i u

Field Information

g g ———

=

- - - E ] T l—
String
MName lunique_doc_id vl
Lower
e
String Fixed
368
Segment [TLog igue D
Expire Date |:| User Exit sh 5HA-256
Page Count Document Sige Updateable Encryption
Logkdown CF53-CMOD Full Text Index
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Hash SHA-256 support

New in server version 10.1, Content Manager OnDemand can store a 64-
byte string generated by using the SHA-256 algorithm for each document
in the database when Hash SHA-256 support is enabled.

The value uniquely identifies the document in the database. If a document
is stored with more than one row of indexes (multi-key), all rows will have
the same Hash SHA-256 value.

The Hash SHA-256 check box will only be active if the data type of the
field 1s String, the Type is either Filter or Index, and the Application
Identifier Field, Reference, Partition, and Cluster check boxes are NOT
checked. The String Case 1s set to Lower, the String Type 1s set to Fixed,
and the String Length is set to 64.

-

Also new in server version 10.1, Content Manager OnDemand native
encryption support encrypts your physical data, requires no hardware,
software, or application changes, and provides transparent and secure key
management.

Encryption is an effective way of protecting sensitive information that is
stored on media or transmitted through untrusted communication
channels. Encryption is mandatory for compliance with many government
regulations and industry standards.

Content Manager OnDemand native encryption utilizes AES256
encryption regardless of the external storage manager. The system itself
encrypts the data before it calls the underlying storage manager to write
that data to media.

Encryption must first be enabled at the instance level. Then individual

application groups must be configured to use encryption. Only data loaded

after encryption is configured will be encrypted. Existing data will remain
unencrypted.

More details about implementing encryption with Content Manager
OnDemand can be found in support item 7049568.

Add an Application Group ES
-- - W - ag— - ——
S— Figld Information - e S g
String
MName lhash 7]
Lower
-
String Fixed
a4
Segment D Log Unigue ID
Expire Date [ user Exit sh SHA-256
Page Count Document Size Updateable k cryption
Lockdown CF5-CMOD Full Text Index

WM
Document encryption support

Add Document function on File menu

In V10.1, the OnDemand Client adds support to add individual documents
from your workstation to a Content Manager OnDemand folder.

In the OnDemand client, open a folder, then click on File > Add
Document.

L

% OnDemand
File | Edit WView Search MNotes Options Window Hel

Lagon... Ctri+L h

Logon To Unified Server 2

nt List

Logoff Ctrl+0Q

Change Logon Password... |

Add Document.., Ctrl+M

Open Folder... L} Ctrl+0

Close Folder

The Add Document dialog is displayed. Select the Application Group and
Application, then fill in the values for indexes and select a file on your
workstation. Click OK and the document will be loaded into Content
Manager OnDemand.

nWW«m—-\

-

[ Add Document |E|
E [ Application Group |UserDeﬁnedData ﬂ oK
{ |- Application |WORD j Cancel
; | B -

File_Mame | ODMewsletter2017Q 1, docx |

File_Title | - First Quarter 2017 Newsletter |

File_Description | ut Content Manager OnDemand |

ELI
kg Document_Date I:l
File Name Ci\Mewslettersh ﬂ March, 2017 ﬂ
26 27 2 1 2 3 4
5 6 7 8 % 10 M
12 132 14 15 16 17 18
{J 19 20 1 2 23 M B

26 @k 23

2 3 4 5

29 0 1 1

g 7 2

Today: 6/23/2017
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Easier access to the AGID |

Determining the application group identifier (AGID) and identifier (also
known as the AGID name) has previously been a somewhat lengthy
process, requiring you to view the application group in the OnDemand
Administrator client, then click on the Storage Management tab, and then
the Advanced button.

That process has been simplified when using the V10.1 OnDemand
Administrator client. The AGID and AGID name can now be added to
the Application Groups view. Logon to your Content Manager
OnDemand instance, click on Application Groups, then click on View >
Choose Details from the menu bar. The AGID and Identifier are now
available. Click on one or both of these items, then move them up or down
in the list as desired.

-

Choose Details

g

Select the details you want to display in the list,

Details

Mame
[|Description
Modified
Maodified By
Last Load
Last Query
Last Refrieve
AGID
Identifier

IT

OOEEEEEE

Click OK to save your changes, and the AGID and Identifier are now
displayed in the Application Groups list. This enhancement works for all
V9.0, V9.5, and V10.1 instances when used with the V10.1 OnDemand
Administrator client.

Contents of 'Application Groups' 4

Mame AGID Identifier Description

§ D2Invoice 6934 IUA Johnson Invoices

&7 DAILYBILL 6269 VA Alpha Sort Transaction Report - Hospital D

& DELQCY 6271 WA Murneric transaction report - Loan Delinquen

& DMR352P 6273 AMA Swedish Transaction report - Faktura Journ

& DSDRPTOL 6904 ALA Large Segment Size

& DTLBILLS 6276 YA Group Range Triggers - Patient Bills

§ EB311& 7054 RVA French complex triggers, fields, defaults, d

& EB3118PR 6278 ZMNA Factures ALTZEE

& EDFACT 6280 ACA Factures Format INFOLOG - Overprinting
6282 E peort d'Enlevernent
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Easier access to server properties

Determining the connection properties for an instance has previously been
a tedious process, requiring right clicking on the instance name in the
OnDemand Administrator client, then clicking the Properties option on the
pop-up menu.

That process has been simplified when using the V10.1 OnDemand
Administrator client. The connection properties can now be added to the
OnDemand Servers view. Click on OnDemand Servers, then click on
View > Choose Details on the menu bar. In addition to connection
properties, such as Host and Port, the Operating System and Database are
also available for selection.

pr

Choose Details | ) |

Select the details you want to display in the list.

Details

il [ vovep |
I |Protocol

[ |Host P—
[¥|Part - W

[ |Unified Logon
[ |Use 551 Select Al
[J|Operating System Deselect Al
7l Database

For TCP/IP servers, the Database, and Operating System column will be
empty until the server is logged on the first time. Once the server is logged
on, the columns will be updated and will appear in the column even when
the TCP/IP server is logged off.

Click OK to save your changes, and the connection properties are now
displayed in the OnDemand Servers list. This enhancement works for all
V9.0, V9.5, and V10.1 instances when used with the V10.1 OnDemand
Administrator client.

Contents of 'OnDemand Servers'
Mame Port Operating System Database
od10aix 1445  AIX DB2
od95aix 1445  AIX DE2
od9aix 1491  AIX DE2
45]¥_ONDDEU 1507 IBM i DB2
a5 ¥_ONDELL 1508 IBM i DB2 {
5] ¥_ONDENU 1511 IBM i DB2
45]¥_ONDESP 1512

1514 DB2

Report Wizard enhanced

In server version 10.1, configuration of Enhanced Retention Management
in the Report Wizard has been simplified.

e The database field name is now fixed (the same way it is for Full
Text Indexing, Document Size, and Page Coount) and is set to
doc_hold.

e The folder field name specified is created as a field of type Hold that
allows the end user to search for a specific hold.

e The Display Document Hold option allows the administrator to set
that option without having to edit the folder after the Report
Wizard completes.

Report Wizard

"

Enhanced Retention Management

|Ise Enhanced Retention Management?
) Mo
@ Yes

[] 1mplied hald

Folder Field Mame
Hold Mame

Digplay Document Hold

Configuration of the new Unique Document ID, Hash SHA-256, and
Encryption capabilities can also be done using the Report Wizard.

e The database field names are fixed as unique_id, encrypt_fld, and
hash_sha?256.

e Folder fields are not added for these capabilities, but can be added
manually if necessary, for example, if the Unique Document ID
needs to be exposed to the end users.

N’“‘“ﬂf TN AT

[] Document Size Field

[] Page Count Field

[ Unigue ID Field ["|Hash SHA-256 Field

[] Encryption Field

J |

< Back ][ Mext = ] [ Cancel
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Tips — Multiplatforms — V10.1 Tips — z/0S
0S/390 indexer support expanded \ OnDemand for z/0S is now 64-bit z/0S Quick Hits

Beginnir'lg in server version 10.1, the OS/390 indexer is now supported on At server version 10.1, most components of Content Manager OnDemand Use care when putting DB2 into maintenance mode

all Multiplatforms servers. In Content Manager OnDemand V9.5, the for z/OS are now 64-bit, including the server, the exits, the OS/390 . _ o

057390 indexer was only supported on AIX (64-bit) in addition to z/OS. indexer, and the Content Manager OnDemand Distribution Facility We've had reports (?f OAM t.hread' isolation support (OTIS) not functioning
(ODF). Some (but not all) exits will need to be recompiled for AMODE 64. properly after running DB2 in maintenance mode. Be sure to recycle both

See the V10.1 Read me for more details. OTIS and OAM afterwards to ensure there are no problems.

New active/active support

. . LE Error Handlers often mask the original cause of a SOC4 in
New in V10.1, active/active support allows multiple Content Manager SUDport for ZEnterprlse Data Compressmn Content Manager OnDemand

OnDemand servers to be active at the same time against the same Content
Manager OnDemand instance when leveraging a highly available database,
such as DB2 pureScale.

Support for zEnterprise Data Compression (zEDC) is available with server Don't be surprised if, after reporting a SOC4 in ARSLOAD to Content
version 10.1 and z/OS version 2.2 for OD77 and OD77Lite compression Manager OnDemand software support, we ask you to do the following:
methods (on z/OS servers only).

Content Manager OnDemand will automatically attempt to use zEDC Add the following inline in the JCL: (or use any other method you prefer

New external Storage managers ‘ unless configured not to by using the ARS_USE_ZLIB_HW=0 setting in for changing the LE parameters)
*
Support has been added in Content Manager OnDemand V10.1 for the the ARS.CFG file. 1/'2;;5'3:;;(; (U A?ISIM)
following external storage managers: TRAP (O, NOSPIE) .
e Amazon S3 RPTOPTS(ON)
e IBM Cloud Object Storage (formally Cleversafe) /*

e OpenStack Swift (support originally released in 9.5.0.4)
e Apache HDFS (support originally released in 9.5.0.4)

Create an IEASLPxx member as follows:

SLIP SET,ID=QQQQ,COMP=U4039,A=SVCD,JOBNAME=arsload,

e [File S
te System JOBLIST=(arssockd,arsload, *MASTER*),

Storage node passwords are no longer exported when the storage set is SDATA=(ALLNUC, CSA,GRSQ, LPA, LSQA,PSA,RGN, SQA,SWA, TRT,SUM
exported for the following storage managers: ,XESDATA),
END

e IBM Spectrum Protect™ (formerly Tivoli Storage Manager)

e Amazon S3 where ARSSOCKD is the name of your ARSSOCKD server and

e IBM Cloud Object Storage ARSLOAD is the name of your load job.

e OpenStack Swift To enable the slip, issue the following console command "SET

e Apache HDFS SLIP=XX" where XX is the suffix of the IEASL.PXX
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Tips —1BM i- V10.1

o

On the Database Field Attributes tab, the graphical indexer increases the

1 i 1 Ind P rti
Default Appl]cat]on G roup table size AESETTIGRETE string length to a size that is sufficient to hold the data that you have
When using the V10.1 OnDemand Administrator client, the default Data Format | Qutput Information selected. If you expect that other possible values for the field might require
database size for newly created application groups is now Single Table for Car more space than Content Manager OnDemand (':alculated, you can
Data Conversion | Mo override the length by typing a different number in the space provided.

All Loads. Previously it was 10,000,000 rows.
In the example shown below, because the data is Greek, the Database Field

The default applies to all supported server versions on IBM 1 (such as V9.0, Line Count . ;

V9.5, V10.1). In other words, any time you create a new application group Fie Format Attributes Length should be increased from 52 to 60.

using the V10.1 OnDemand Administrator client, the default will be Single 1= rerma i Add 2 Field =
table for all loads when logged on to an IBM 1 server. Length arie

Note that certain changes may result in a new table being created, for Font Information Iw Database Field Attributes

example, switching from old style to new style dates.

CHAR
TRC Field Names

UTF-8 support \ PRMode -

Content Manager OnDemand server version 10.1 adds UTF-8 support on
IBM 1. UTF-8 support is sometimes referred to as Unicode support. UTF-

8 support is valid only for new instances. Conversion of existing instances

Databasg Field Mame  customer_name

Code Page
- Folder Field Mame Customer Name

MCF2 Ty

to UTF-8 is not supported. When creating an instance by using the Create '

Instaré:é (SCRTIN STOND) Corréman?, there 1s é gesw Database files ?CSID When ind ored i ed he Code P _y string

DBF ID) parameter available. If the DBF ID parameter value is en mdexes are stored, they are converted from the Lode Fage speciiie _

gpeciﬁed as *%jlz[‘Fg when you run the CRTINSTONDpcommand, a on the Indexer Properties dialog to UTF-8 (CCSID 1208). String Database Field Type

parameter entry of ARS_IBMI_UTF8_TABLES=1 is added to the conversion between code pages might result in an increase in the length of _ Case
ARS.CFG file for the instance. This parameter setting causes all character the string when data is loaded on the server. For example, the OnDemand Bata Type |Sting hd

fields in all database files in the instance to be created with a CCSID setting Administrator client might require two bytes to display a double-byte Type
of 1208. The ARS_IBMI_UTF8_TABLES parameter value must not be character, yet the server might require three bytes to store the character in Segment

changed after the instance is created. The ARS_IBMI_UTF8_TABLES the database. Expire Date Length 52

parameter must not be added manually to the ARS.CFG file for any new or
existing instances. Note that the instance is still created with specific
Language ID (LANGID) and Locale (LOCALE) parameter settings. The

instance server job will run in the specified language and locale.

When storing data for languages such as Greek, Russian, and Arabic, it is
recommended that you create application group string fields that are
double the length you would use if the instance did not support UTF-8. For
other languages, if your index values contain accented characters, you will

Jobs loading data into a UTF-8 instance must NOT have a CCSID value of need to make the fields longer.
65535. If the job that is loading data has a CCSID value of 65535, the load
will fail with message OND2049 - Application group not found. To resolve
the problem, you can change the job to have a different CCSID value,

When selecting a string, the graphical indexer will set the Field Length to
the length selected in the sample data.

: S Ve
change the CCSID setting of the user profile, or change the Coded COYPNCVL Y sttt i v N
N @EC ACEARQIOYACY AEMHTEA EQA: 028005890
character set identifier (QCCSID) system value. SAPMATETA sz, _nnonnscan
When storing indexes in a UTF-8 instance, it is important to note that some EON| - Add a Field [
h ill th byte when stored in a UTF-8 field. Lati e
characters will use more than one byte when stored in a -8 field. Latin Field Information | Database Field Atrbutes |

lowercase and uppercase characters [a-z] [A-Z] and Arabic numerals [0-9] non
use only one byte. Accented characters might use two bytes. DBCS

| toentter [Fed1 : Troger
characters might use two or three bytes. [Fe ] 90=" (Ingg=r

When using the graphical indexer of the OnDemand Administrator client Default Value Base [D ']

with a UTF-8 instance, the Indexer Properties dialog will be presented 201 Constant Value Field Length 30

before your sample data is displayed. You must set the Code Page to the
value that matches the data being indexed. \M'\M“_—”ﬁ
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Spooled file selection enhanced

When selecting a spooled file to download for use in the OnDemand
Administrator graphical indexer, the list of spooled files displayed is now
limited to the data type chosen in the Report Wizard, or the current data
type of existing applications.

Report Wizard @

This wizard steps you through the process of defining a
repart to Content Manager OnDemand.

Select the indexer that will be used to index the data.

| os/400 -

Sample data will be used to provide most of the information.
The remaining information will come in the form of gquestions.
Select the name of a sample data file and begin defining
field and index information.

Select the data type that will be used when viewing the data
once it is stored in Content Manager OnDemand.

AFP - [ Select Sample Data. .. ]

SC5-Extended

After choosing your data type, click the Select Sample Data button. On the
Select File dialog, enter a value for the User or Output Queue and click the
Retrieve List button. The list of Available Spooled Files that is displayed
will be limited to the data type (File Type) you chose earlier.

RNV S R 2 VA AR NN e Wy
Available Spooled Files

78 spoaled files
File User Data Form Type Job User File Type | Pages *
PURCHORD  MF50000061  *5TD QPRTIOB DERYAMNT *AFPDS Gl
QSYSPRT OED04B1 51D QPRTIOB DBRYAMT *AFPDS 23
HCFAPRTF HCFA1500 ST QPRTIOB DERYAMNT *AFPDS 21
QSYSPRT ATMC =T DLES25DMAA  DERYAMNT *AFPDS 2
QSYSPRT ATMC 51D DLBES25DMAA  DBERYAMT *AFPDS 4
WAFDOC AFPLO ST IDXFRA DERYAMNT *AFPDS 128
ABINVRX1 ABINVEX1 =T IDXFRA DERYAMNT *AFPDS 10
UBS2PRTF uBs2 51D IDXFRA DBRYAMT *AFPDS 21
HCFAPRTF HCFA ST IDXFRA DERYAMNT *AFPDS 21 i

This enhancement is available at all V7 releases and is independent of the
server level of the system. The required PTFs are:

V7.1 V7.2 V7.3
S165047 S165048 S165049
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0S/400 Indexer rewritten

The OS/400 indexer has been rewritten in server version 10.1 for
improved performance and enhanced error handling. In our testing,
indexing times, as captured in the System Load facility, were reduced 30%
to 60%. Your results will vary based on your input data and system
performance. The rewritten OS/400 indexer is included with, and
requires, server version 10.1.

AFP resource collection enhanced

The AFP resource collection performed by the OS/400 indexer is
enhanced to support resources located in the IBM i Integrated File System
(IFS).

Previously, AFP resource collection did not recognize AFP resources if they
were found in the IFS. Resource collection can now handle both library-
based resources and IFS-based resources. This will now allow spooled files
that use IFS-based resources to be archived.

This enhancement is available beginning at server version 10.1.

System administrator authority required to use

IBM Navigator for i

Content Manager OnDemand system administrator authority is now
required to perform all of the operations provided by the Content Manager
OnDemand component of IBM Navigator for i, not just the creation of
migration policies.

This change has been made for all V7 releases.

Additional Information

Knowledge Centers

Content Manager OnDemand for Multiplatforms Knowledge Centers

Content Manager OnDemand for z/OS Knowledge Centers

Content Manager OnDemand for 1 Knowledge Centers

Publication Libraries - PDF versions of the documentation

Multiplatform Version 9.0 Version 9.5  Version 10.1 - Use the
Knowledge Center
z/0OS Version 9.0 Version 9.5 Version 10.1 - Use the
Knowledge Center
o . . Version 7.3 - Use the
IBM 1 Version 7.1 Version 7.2 Knowledge Center
Product System Requirements
Multiplatform Version 9.0 Version 9.5 Version 10.1
z/0OS Version 9.0 Version 9.5 Version 10.1
IBM 1 Version 7.1 Version 7.2 Version 7.3

More Enterprise Content Management web sites

Content Manager OnDemand Product Overview

Compatibility Matrix for the CMOD clients and servers

Content Navigator Product Overview

IBM Software Support Lifecycle Policies (search for Content Manager
OnDemand)

Social Media

Follow @IBM_ECM on twitter for almost real-time news & updates on
Content Manager OnDemand. For more information and links to all social
media sites, see support item 1673183.

OnDemand User Group
The primary objective of the OnDemand User Group (ODUG) is to create

an environment and network encouraging the exchange and development
of information regarding Content Manager OnDemand and its associated
products.

Copyright and trademark information

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

A current list of IBM trademarks is available on the Web at "Copyright and trademark
information".
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http://www-01.ibm.com/support/knowledgecenter/SSEPCD/welcome
http://www-01.ibm.com/support/knowledgecenter/SSQHWE/welcome
http://www-01.ibm.com/support/knowledgecenter/SSB2EG/welcome
http://www-01.ibm.com/support/docview.wss?uid=swg27022033
http://www-01.ibm.com/support/docview.wss?rs=129&uid=swg27041745
http://www-01.ibm.com/support/docview.wss?uid=swg27022034
http://www.ibm.com/support/docview.wss?rs=86&uid=swg27041744
https://www.ibm.com/support/docview.wss?rs=152&uid=swg27016915
http://www-01.ibm.com/support/docview.wss?uid=swg27041971
http://www-01.ibm.com/support/docview.wss?uid=swg27021456
http://www.ibm.com/support/docview.wss?uid=swg27043162
http://www.ibm.com/support/docview.wss?uid=swg27049167
http://www-01.ibm.com/support/docview.wss?uid=swg27021524
http://www.ibm.com/support/docview.wss?uid=swg27043163
http://www.ibm.com/support/docview.wss?uid=swg27049166
http://www-01.ibm.com/support/docview.wss?uid=swg27016180
http://www-01.ibm.com/support/docview.wss?uid=swg27041914
http://www.ibm.com/software/reports/compatibility/clarity-reports/report/html/softwareReqsForProduct?deliverableId=0122A30034AA11E58AF985BE84618DBC&osPlatforms=IBM%20i
http://www.ibm.com/software/data/ondemand
https://www.ibm.com/support/docview.wss?uid=swg21392275
http://www-03.ibm.com/software/products/en/content-navigator
http://www.ibm.com/software/support/lifecycle/index.html
https://twitter.com/IBM_ECM
http://www-01.ibm.com/support/docview.wss?uid=swg21673183
http://www.odusergroup.org/
http://www.ibm.com/legal/copytrade.shtml
http://www.ibm.com/legal/copytrade.shtml

